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MathStar Overview
MathStar is a math program that uses a Flash card type of display to help kids learn basic 
math facts.    MathStar has been designed for use in both the classroom and at home.    

The user interface allows for easy selection of problem types and number ranges.    
Selectable sounds, in systems with Windows supported sounds, provide    a means of re-
enforcement and notification.    A programmable timer can be enabled to time the problem 
sets.

Teachers can use MathStar to design tests for their class.    The results of the practice tests 
for each student can be individually charted.    MathStar offers security for the tests and the 
students results with password protection.

I hope that you will find MathStar a useful tool in teaching basic math facts.

Roger Winstanley
Winstanl@erols.com



Whats New for MathStar v1.40!
MathStar now offers selectable min and max number ranges.
Improved graphics and window management.
Added support for path to sound files.
Improved Login.
Now MathStar detects and handles version upgrades better.
Removed some minor bugs.

Runs under Win95 and WinNT 4.0!
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Logging Into MathStar
You can log into MathStar by choosing the Login entry from the main menu.    This will bring 
up a dialog box where you can enter your teachers name and your own name.

Teachers see Administrators Login.



Selecting Number Ranges
You can select the number ranges that will be used in the problems.    To do this, chose the 
Number Opt entry under the OPTIONS menu.    A dialog box will appear.    This dialog box is 
used to set the min and max numbers that will be used in the problems.    Both numbers can 
be set individually.



Selecting the Math Operators
You can select which math operators to use in the problems by choosing the Number Opt 
entry under the OPTIONS menu.    A dialog box will appear.    Addition, subtraction, 
multiplication, and division can be individually enabled for use in the problems.



Selecting Answer Style
This selection defines how answers are entered into the computer.

    Write Answers from Right to Left

Choosing Right to Left promotes use of columns in maintaining decimal places.    For 
instance, the answer to 8 + 8 would be entered in as 6, in the ones column, followed by 1, in
the tens column.

    Write Answers from Left to Right

Choosing Left to Right sometimes seems more natural for small numbers.    The answer to 
the problem 8 + 8 would be entered in as 1, in the tens column, followed by 6, in the ones 
column



Selecting Timer Options
MathStar provides a timer that can be used to time the problems.    The timer is displayed in 
its own status window.    It can be used in one of two ways.    The first method times each 
problem for the total number of problem in the set.    For instance, the time per problem can 
be set 10 seconds for each answer.    At the end of ten seconds the timer will expire and, if 
sound is enabled, an alarm will sound.    The second method times the set of problems.    This
method is used to see how many problems can be done in a certain time.

    Enable Timer

Checking the Enable Timer box will default to timing each problem.    Enabling the timer will 
bring up the timer dialog box.

    Time per Problem

This box is used to set the amount of time for each problem.

    Total Time Max

Show Timer Gauge For:

    Each Problem

When the timer gauge option set to Each Problem, the gauge in the timer dialog will expire 
at a rate proportional to the time set in the Time per Problem box. When time expires, if 
Sounds areenabled, a wrong answer sound will be played.    The problem or any fail counts 
do not change.    This audio signal is only used as incentive.

    Entire Problem Set

When the timer gauge option set to Entire Problem Set, the gauge in the timer dialog will 
expire at a rate proportional to the time set in the Total Time Max box. If time expires before 
all of problems are done, STOP will be written in the answer space.    No more problems will 
be given.



Selecting Sound Options
    Enable Sounds

Checking the Enable Sounds box will, guess what, turn on the sound!    If your computer has 
a sound card that is supported by windows, some interesting sounds will be heard.    If not, 
only some boring dings and beeps will be heard.

    Wave File Path

The path to where you keep your .wav files can be entered here.    Enter your path and then 
tab to the next box.    The new path will be detected and update the sound selection boxes.

Most of the sounds that will be heard can be selected by the user.

    Correct Answer Response

Sound played after each correct answer.

    Wrong Answer Response 1-4

One sound played after each wrong Answer.    

    All Problems Correct

Sound played at the end of a problem set if all problems were answered correctly.

    Try Again

Sound played after a successful Review      of missed problems.



Test
Start the Teachers Practice Test problems!    Mathstar will use the number ranges, operators, 
and other options that have been set by the Teacher.    Teachers can setup practice tests by 
logging in as the Administrator.



Warm Up!
Start doing warm up problems!    Mathstar will use the number ranges, operators, and other 
options that have been set by the student.



Stop!
Stop doing problems!



Review
Review the problems that were answered incorrectly.



Saving Your Setup
To save your current setup, chose Save under the File menu.    All of the options that you 
have selected will be saved and restored the next time you log in.



Logging Off
To Log off just chose Logoff from the main menu.    Your current setup will be saved.



Administrator's Login
Teachers can setup some special features of MathStar by logging in as an Administrator.    
These features include:

Creating Tests
Charting Test Results
Enabling Students Charts
Enabling Passwords

To login as an Administrator, enter your name as the Teacher and the word Administrator in 
the Student box.    You will be prompted for a password. 
 



Creating Tests
The Teacher can create a test for the students to practice with.    The results of this test will 
be kept with the Students profile.    The test results can then be reviewed and charted by the 
teacher, see Charting Test Results.    The Teacher can also enable the Student to see their 
charted test results, see  Enabling Students Charts. 

To create a test the Teacher must login as the Administrator.    Under the Setup menu, 
choose create test.    The Number Ranges, Operators, and Timer Options can be set for the 
practice test.

If the test is changed, all of the Students old test results will be cleared.

A single test can be saved under each teachers name.    If a teacher needs more than one 
test, the teacher can add some additional identifier to their name for each class.    For 
example, Mrs. Smith Blue.



Charting Test Results
A Teacher can chart their Students test result by logging in as the Administrator, and 
selecting the Review Tests menu item.    Each Student can be selected individually and their 
test results plotted.    The Chart will plot the test results for the last eleven times that they 
have taken the test.



Enabling/Disabling Students Charts
The Teacher can enable the Students to view their test results chart.    This can be used to 
motivate the Students allowing them immediate feedback on their progress.

To Enable or Disable the Students Charts, the Teacher must login as the Administrator.    The 
Teacher can then enable or disable the chart under the Options menu. 



Enabling/Disabling Passwords
The Teacher can enable or disable the Students passwords.

To Enable or Disable the Students passwords, the Teacher must login as the Administrator.    
The Teacher can then enable or disable passwords by selecting the Options menu. 



Setting Up Classes
The Teacher can create their Class of students.

To create a class, the Teacher must login as the Administrator.    The Teacher can then select 
the Setup Classes under the    Setup menu.    This will bring up a dialog box that can be used 
to add or delete students from their class.    New teachers can also be added here! 



The Keyboard
MathStar is a Windows program and it uses all of the standard Windows keys and 
accelerators.

MathStar is about numbers.    Entering numbers from the normal keyboard is sometimes 
slow.    If your keyboard has a number pad it will be easier to enter the numbers from that.    
The number pad can be enabled and disabled by using the num lock key.

Enter is used to enter your answer or selection.

Backspace will delete one character.

Delete, during problems, will delete the entire answer line.

The Number Keys are used to enter answers.    The answers can be entered from left to 
right or right to left.    See Selecting Answer Style.



Registration
MathStar is distributed as Shareware.    It is not free, freeware or in the public domain.    You 
may use MathStar for a trial period of 30 days, at no cost to you.    If you decide to keep 
using MathStar, you are expected to register it and pay the registration fee.

Who Needs to Register?

Anyone who uses this software for reasons other than evaluation.

When Should I Register?

You are given a 30 day trial period.    In the tradition of Shareware, try before you buy.    This 
trial period is to make sure that this software meets your needs.    After the 30 day period, 
you must register it.

Why?

Because you need MathStar, and it took a lot of time and effort to develop.

How Do I Register?

Print out the Registration Form, fill it out and send it in! 



License Agreement
Copyright © 1994    1997      All right reserved

INSTALLATION OF MATHSTAR ON YOUR COMPUTER SYSTEM IMPLIES AGREEMENT 
WITH THE TERMS AND CONDITIONS BELOW.

DISTRIBUTION OF MATHSTAR, ITS ACCOMPANYING PROGRAMS AND 
DOCUMENTATION IS CONSIDERED AS IS.    THE WRITER OF THIS SOFTWARE OFFERS
NO WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED.    THIS INCLUDES, BUT IS 
IN NO WAY LIMITED TO, WARRANTIES OF MATHSTARS MARKETABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE.    UNDER NO CIRCUMSTANCES WILL THE DEVELOPER 
OF THIS SOFTWARE BE LIABLE FOR ANY DAMAGES WHICH RESULT FROM THE USE 
OF THIS PROGRAM OR THE INABILITY TO USE IT.    EXCLUSION FROM LIABILITY 
INCLUDES, BUT IS NOT LIMITED TO, LOST PROFITS, LOST SAVINGS, OR ANY OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES.

The product name MathStar is heretofore used to describe the MathStar software 
program and the files, which are distributed as being part of the MathStar 
software program, owned by Roger Winstanley.

A person who has paid to use and distribute MathStar in the manner described 
herein is heretofore known as a Registered User.

MathStar is distributed as Shareware.    It is not free, freeware, or in the public 
domain.    You may use MathStar for a trial period of thirty days, at no cost to you, 
to determine if it fits your needs.    If you decide to use MathStar, you are 
expected to register it and pay the applicable registration fee.

You may not modify or dis-assemble MathStar, nor distribute any modified or dis-
assembled versions of MathStar.

You may distribute the Shareware version of MathStar only if the files are 
unaltered, MathStar is in its entirety and no other files are distributed as being 
part of MathStar.    Only Registered Users my distribute files from the registered 
version of MathStar as individual files.    Anyone who receives a file, which is part 
of the registered version of MathStar, may not use the files for any reason other 
than that set forth by the Registered User and this Agreement.

U.S. Government RESTRICTED RIGHTS:    Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the 
Rights in Technical Data and Computer Software clause at 252.227-7013.



MathStar Registration Form

________________________________________________________________________
NAME

________________________________________________________________________
STREET ADDRESS

________________________________________________________________________
CITY, STATE    ZIP

________________________________________________________________________
COUNTRY

________________________________________________________________________
PHONE NUMBER

________________________________________________________________________
INTERNET ADDRESS

_________ x $ 5.00 per copy ____________
Quantity

(Maryland Residence add 5%) ____________

    Total $___________                        

Mail this Registration form with your payment to:

Roger Winstanley
300 Magothy Road
Severna Park, MD    21146






